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1 Safety

1 Safety
The EdgeWave  Laser Control Software is intended to control a EdgeWave
INNOSLAB  laser through a RS232 port of the computer. Laser radiation may
effect a person's health or may otherwise cause damage. Prior to installation
and operation compliance with all relevant laser safety regulation has to be
secured.  The  client  shall  solely  be  responsible  to  strictly  comply  with  all
applicable and relevant safety regulations regarding installation and operation
of the system at any time.
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2 Installation

2 Installation

 2.1 File list
The EdgeWave Laser Control Software is delivered with the following file(s):

• EWLaserControl.exe

EdgeWave  Laser  Control  which  provides  the  full  control  to  the
EdgeWave Laser via RS232 (serial) port.

• EWLaserControl.ini (optional)

The file  used to save all  settings  for  the  EdgeWave  Laser  Control
Software.

 2.2 Requirement
 2.2.1 Hardware requirement

• The EdgeWave Laser Control Software is designed to control  EdgeWave
INNOSLAB  Laser.  A  EdgeWave  Laser  with  essential  peripheral
equipment, e.g. EdgeWave Power Supply, chiller, trigger generator, etc. is
required.

Please read the manual of EdgeWave Laser carefully and connect all cables properly
prior to use EdgeWave Laser Control Software.

• A computer to control the Laser.

◦ A RS232 (serial) port is required to control a EdgeWave Laser with
EdgeWave Laser Control Software. Both on-board com port and
USB to RS232 adapter works.

◦ 2MB free hard drive space.

◦ The software itself will use less than 10MB memory when running,
which can be provided by any modern computer.

 2.2.2 Software requirement
• EdgeWave  Laser  Control  Software works  only  in  windows  platform,

including both 32 and 64 bits version of  Windows 2000,  Windows XP,
Windows Vista, Windows 7 or above .

• Windows user privilege

◦ The  EdgeWave  Laser  Control  Software writes  all  settings  into
EWLaserControl.ini in the same directory when it  is closed. The
setting file will  be created automatically in case of missing. The
Modify, Create and Read privilege to file EWLaserControl.ini must
be granted to current user to avoid some warning message.

◦ The software  controls EdgeWave Laser via the RS232 port. The
Read and Write privilege to the using COM port has to be granted.

 2.3 Software installation and uninstalling
The EdgeWave  Laser  Control  Software is  a  green software which means
NOTHING will be written into the registry or system folder by itself.
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2 Installation

 2.3.1 Installation
1. Copy all files delivered into the destination directory.

2. Create a shortcut to the preferred location. For instance, a shortcut will be
created  on  the  desktop  of  Windows  by  right  clicking  on
EWLaserControl.exe with  the  mouse  and  then  select  “Send  To”  →
“Desktop (create shortcut)”, as shown below:

Figure 1: Create a shortcut on desktop

 2.3.2 Uninstalling
1. Delete the shortcut pointed to  EWLaserControl.exe.

2. Delete  EWLaserControl.exe, EWLaserControl.ini and  any  other  files
copied with this software (if  present)  under  the directory of  EdgeWave
Laser Control Software.
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3 Operation

3 Operation

 3.1 Main window
When launch the Laser Control Software for the first time, it will try to connect
EdgeWave Laser via COM1. If no EdgeWave Laser is connected to this port
(Figure 2), it will try to reconnect automatically for every 1 second by default.
Both COM port and the auto-connect feature are adjustable in the settings.

Figure 2: Main window – Laser disconnected

Figure 3: Main window - Laser connected

To establish a connection to the Laser,  the following requirement must  be
fulfilled:

• A EdgeWave  Laser  is  connected  to  a  working  COM  port  of  the
computer.

• The RS232 cable used to connect the Laser and the computer must
be a 1-to-1 cable.
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• COM Port number has to be specified in the EdgeWave Laser Control
Software correctly.

• Emergency stop button has to be released.

• Safety loops on the rear panel of Laser power supply is connected
properly and the corresponding switches are closed. Please find more
details about safety loops in the user manual of EdgeWave Laser.

• The Laser power supply is connected to the mains and switched on.

Once the laser is found and connected, the serial number of the Laser will be
shown in the title bar and a Laser operation panel appears. This panel provide
a easy way to set most of Laser parameters and display current status. But
only  most  frequently  used  commands  are  implemented  in  this  panel.  An
advanced panel (Figure 4) is also provided, with which all control commands
of EdgeWave Laser can be executed.

Figure 4: Main window - Advanced panel

 3.2 Terms
The terms below are subject to the use of EdgeWave Laser. Their definition is
important in understanding the operation procedure, trouble shooting and so
on.  Some  of  the  definition  are  valid  only  inside  this  manual  and  during
operating EdgeWave Laser.

Laser output Laser output means required Laser beam emitting from
the  output  aperture  of  the  Laser  head.  To  have  Laser
output,  the  following  must  be  fulfilled  if  the  other
necessary  parts  (e.g.  cooling  water)  are  configured
properly and working well:

1. Laser ON
2. The current is higher than the threshold
3. Proper TTL trigger signal is provided if working in

External trigger mode
4. Proper  TTL  signal  for  external  modulator  is

provided if required.
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Laser ON The status of Laser hardware. When Laser On is set, the
control board has to prepare some initializing procedures
for Laser output, e.g. set the current of Laser diodes to
nominal  value and turn the shutter  to output  position if
present.

Laser ON should be considered more like “Laser is ready for ON”. To
have  Laser  beam output,  all  conditions  for  Laser  output  described
above must be fulfilled.

Laser OFF The status of Laser hardware.  When Laser Off is set,
current of Laser diodes is set to 0A despite of the nominal
current  and  the  shutter  is  turned  to  off  position  (if
present).

Q-Switching Most  of  EdgeWave  Lasers  are  working  at  Q-switching
mode,  which  is  a  technique  to  produce  pulsed  output
beam with high peak power and short pulse width. It is
achieved by putting an optical  switch inside the laser's
optical resonator. Normally there is not pulse output when
the switch is off, while a giant pulse is produced once it
switch to on.

Trigger The TTL signal used to control the on/off state of the Q-
switch.  It  controls  the  repetition  rate  and  the timing of
laser pulses. It also regulates the pulse energy in some
kinds of EdgeWave Laser.

Trigger mode Control mode of the Q-switch in EdgeWave Laser. There
are  3  kinds  of  mode:  CW (continuous  wave),  External
trigger and Internal trigger.

CW The Q-switch does not work under CW power. The laser
resonator  will  have  constant  output  if  there  is  enough
pump power

External trigger The  trigger  signal  is  generated  outside  of  EdgeWave
Laser and coupled into the Laser through the Trigger port
of the Laser.  This is the most favorable mode for most
applications because the user can control the timing and
the other features.

Internal trigger The trigger signal  is  generated by the control  board of
EdgeWave Laser. It is not controllable by user. For some
model the internal trigger signal might becomes unstable
at >5kHz.

Branch Some models of EdgeWave Laser have 2 sets of pump
unit. And some also have 2 sets of Q-switching control. It
is called 1 branch for each set of such unit. Each branch
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can be marked as branch 1 and branch 2, or  Laser 1 and
Laser   2.  The  output  aperture  is  not  relevant  to  the
amount of branches.

Hyper Terminal A  windows  application  of  terminal  emulation  which
supports  communications over TCP/IP networks, Dial-Up
Modems, and serial COM ports (RS232). It was bundled
with Windows from version Windows 95 to Windows XP.
This  tool  is  useful  for  troubleshooting.  There  are  also
some other software provides similar functions.

 3.3 Main menu and tool bar
Main menu Toolbar button Shortcut Usage

File → Connect Laser 
 

Ctrl + L Connect or disconnect Laser

File → Exit Alt + X Close the software

View → 
Minimize to system tray

Hide main window and show a
small icon in the Windows tray
area on the taskbar when this
item is checked. Click on this
icon  will  bring  the  main
window back.

View → 
Show tray icon

Always  display  the  icon  in
Windows tray when checked.

View → 
Show advanced panel

Ctrl + D

Display  a  HyperTerminal like
interface  (Figure  4)  for  extra
controls over the Laser. More
details  are  described  in
chapter 3.5.

View → Options Ctrl + O
Display  the  options  dialog  to
configure the software.

Help → About F1
Display  the  copyright  and
version information (Figure 5).

Figure 5: About dialog

 3.4 Regular operation
The  regular  operation  panel  provides  a  GUI  (graphical  user  interface)  to
interact  with  a  EdgeWave  Laser.  Only  a  few  value  inputting  and  mouse
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clicking are required with such panel to control the Laser, instead of the user-
unfriendly commands. Most of Laser operation can be done here.

Based on their functions, the regular operation panel is divided into 4 blocks:
Trigger control, Current control, System functions and Laser status indicator.

 3.4.1 Laser On/Off status

Figure 6: Warning symbol

The  Laser  status  indicator  is  located  at  the  bottom-right  corner  of  the
interface.  It  shows the On/Off status of the Laser through the color  of the
warning symbol.  The On/Off  here is  not  the same as the output  of  Laser
beam. Please refer to section ?? for the definition of Laser On/Off.

A colorful (yellow and black) symbol indicates Laser is in On
state.

A gray scale symbol indicates Laser is in Off state.

The indicator might not be updated in time if the auto-update feature is deactivated or the
updating interval is too long (section 3.6 below)
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 3.4.2 Trigger control

Figure 7: Trigger mode

Trigger  control  panel  is  located  at  the  top-left  corner  of  the  interface.  it
consists the display of actual settings, input fields for frequency values and
buttons for changing trigger mode.

• Input frequency

The internal  trigger frequency in Hz can be input in the edit box(es).
Only integer value is allowed. Press Enter key  (if  the input focus is
inside the edit box) or click on the green check symbol to send it to
laser  control  board  when  correct  value  is  set.  New  value  will  be
displayed above in the actual settings area if the sent one is accepted.

• Actual settings

The actual trigger mode and frequency are displayed here. The values
inside  the  input  boxes  do  not  represent  the  values  in  the  Laser
controller.

• Change trigger mode

The trigger mode can be changed easily by clicking the corresponding
buttons. When internal trigger is set, both Laser 1 and Laser 2 (if there
are 2 branches present) will be set to internal mode simultaneously. 

In some Lasers equipped with certain first pulse killer, the frequency set here also tells the
controller to perform the pulse optimizing according to this frequency. For such Laser, the
maximum working frequency must be set here. Otherwise the Laser might be locked down at
lower power level, or pulse energy is unstable.

The  appearance  of  trigger  control  panel  varies  with  the  Laser  hardware
configuration. 
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Both branches have independent control
on  trigger  mode and  frequency.  When
press Enter  key inside one of  the edit
box,  the frequency will  be send to the
relevant  Laser branch only.  By clicking
the green check symbol, values of both
branches will be transmitted.

Both branches have independent control
on  trigger  mode  and  share  the  same
frequency setting.

There is only one branch installed inside
the Laser.

 3.4.3 Current control

Figure 8: Current control

The current applied on the Laser diodes regulates the output power of the
optical  resonator  in  a  diode  pumped  Laser.  For  most  applications  with
EdgeWave Laser, the power level or pulse energy achieved from Laser head
has  to  be  controlled  through  the  diode  current.  Current  control  panel  is
located at the top-right corner of the interface. it consists the display of actual
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settings,  input  fields  for  current  values  and  some  control  buttons.  The
appearance varies with the configuration of the connected Laser hardware as
well.

• Input currents

Currents in ampere for Laser diodes can be set here. Nominal values
is sent to the controller only after press Enter key in the edit box or
click on the green check symbol next to it. New value will be shown in
the display area if it is accepted. The decimal separator (dot) cannot
be erased and always stays inside the edit box.

If the given value is larger than the maximum current of the corresponding Laser
branch, the maximum value will be used instead.

• Actual settings

Current settings are always displayed in this area. Displayed items are
selected automatically by the software itself according to the type of
Laser.

• Control buttons

Turn Laser ON. Please refer to section ?? in page 6 for the
definition of Laser ON.

Turn Laser OFF. Please refer to section ?? in page 6 for the
definition of Laser OFF.

Synchronized  control  over  current.  Appears  only  when  2
Laser branches available. Click it once, the button will keep
down. Click  again it will be released. When this button is
down,  currents  for  both  branches will  be  changed
simultaneously  with  the  same  value.  Some  models  of
EdgeWave  Laser  have  such  function  implemented  inside
the Laser controller. It should be ignored in such case.

This button is not functional any more.

The edit box is always in overwrite mode. It is unnecessary to delete the old value and then
type in new one. Recommended operation is to place the cursor at the right position with
cursor key or mouse,  and then type in the new digits. By using delete or backspace key, it is
easier to input a number like “0 .00” with a space between the first digit and the decimal point
by mistake, which will bring a warning dialog when trying to send such value. Leading and/or
trailing space is acceptable.

Always find out the current in the “Actual Settings” area instead of the edit box!
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 3.4.4 System functions

Figure 9: System functions

• Information box

The information box is a small window to show the error messages from
the Laser head. Right click within this window will  bring a popup menu
with which the contents can be copied or cleared.

Figure 10: Error code and description

Error code shown inside the information box is a 2-digit-number enclosed
with square brackets and located at the beginning of a line. For instance,
the picture below shows that  error  94 was found,  which means chiller
error happened. More details about error codes can be found in the Laser
manual. The [r90] in the first line of  Figure 10 meant the command  r90
was executed to query the laser status.

• Control buttons

Save all current settings (including trigger frequency and mode,
nominal  current,  etc.)  into  Laser  controller  as  default  values.
Once saved, those settings will be restored after next reset or
starting up the power supply. 

Click this button to check the Laser status if it cannot be started
or the laser stops suddenly during operation.  Error codes and
description will be shown inside the information box in case of
error  happened.  Only a line with time and “[r90]Query Laser
status” will be shown if there is no error presently.
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If  laser error happened and solved, click this button to try to
clear the errors and release the laser from a lock down state. A
dialog with a processing bar like below might appear during the
clearing procedure. Normally it will disappear automatically after
the procedure is accomplished. Anyhow, it can also be closed
by clicking the “Stop Waiting” button at anytime, or when it stays
for too long.

Click the reset button to perform a cold start. By doing this the
Laser  will  be  turned  off  (if  it  is  on)  and  all  settings  will  be
restored  to  the  default  value  saved  before  (using  “Save
settings”  button  of  command  “w98  101”).  A  dialog  with  a
processing bar like below will appear during the rest procedure.
Normally  it  will  disappear  automatically  after  the  reset  is
accomplished.  Anyhow,  it  can also be closed by clicking the
“Stop Waiting” button at anytime.

 3.5 Advanced panel
The  advanced  panel  is  a  terminal-like  window  for  all  commands  that
EdgeWave Laser supports. Since the GUI provides basic controls only, the
unimplemented  commands  must  be  carried  out  here  or  use  a  terminal
emulation software (e.g. HyperTerminal) instead.

When the software is showing the advanced panel, the  automation functions introduced in
section   will  be  deactivated  automatically.  In  this  case,  the  software  will  not  detect  if  a
EdgeWave  Laser  is  connected  or  not.  If  a  Laser  is  disconnected  and  another  Laser  is
connected during this, nothing will be updated including the SN in the title bar and the layout
of  the controls. It  has to be done by disconnect and connect again manually.  Automation
functions will  be activated when back to the simple panel if  the feature is enabled in the
settings.
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Figure 11: Advanced panel

The advanced panel consists of input box, command history and message
box.

• Input box

A command should be input in this box. Press Enter key when the input
focus is inside this box, or click the small button on the right side to send
out a non-empty command (empty command means spaces only).

In a terminal emulator, e.g. HyperTerminal, keystroke is sent out immediately. As a result,
improper  key sequence cannot  be corrected.  Unlike it,  the command can always  be
revised inside the input box before sent out.

• Command history list

This box holds a list  of  recently used commands. Once a command is
send through the input box, it will be appended to the end of the history
list if no duplicate is found. To resend one of command, just double click
with  the  left  button  of  the  mouse  on  the  item,  or  single  click  to
select/highlight the item then click the button on the right side of this box.

• Message box

After switch to advanced panel, all commands sent to Laser through the
input box and messages received from it  are displayed here. Outgoing
command is in red, while incoming message is in blue. Right click inside
this small window will bring a popup menu with which the contents can be
copied or cleared.

Normally, the respond for the sent command is shown right  behind it in the same line. In
some  cases,  e.  g.  when  the  Laser  is  populating  the  oven  temperature  information,
messages could be interrupt, but it is still visible.
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 3.6 Options
 3.6.1 General options

Figure 12: Options - General

• Laser port

A EdgeWave  Laser  should  be  connected  to  the  computer  through  a
RS232 interface.  The EdgeWave  Laser  Control  Software has to  know
which serial port is connected to it. The software can enumerate the COM
ports present in the computer which will be shown when click the down
arrow in the drop-down list  window. The list  will  be updated only when
click the button. If a COM port is inserted after the list is shown, it could be
found by folding the drop-down list and open again.

In some cases, the software might be failed to fetch all COM ports information. The port
number can also be inputted manually in the edit box even it is not listed here.

• Update laser parameters automatically

When  this  feature  is  enabled  (checked),  the  software  will  update  the
information  of  the  laser,  including  Laser  On/Off  state,  trigger  mode,
internal trigger frequency, current and maximum current, at the specified
interval. The connection between the computer and the Laser will also be
detected in the meantime.

• Detect laser connection

When this feature is enabled (checked), the software will check whether a
powered on EdgeWave Laser is connecting to the specified COM port or
not at the specified interval. In either of the following situations

◦ Laser is not connected to the computer or power off when start the
EdgeWave Laser Control Software,

◦ Laser  was  connected  and  controlled  by  the  EdgeWave  Laser
Control  Software.  The  cable  is  disconnected  or  broken  during
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normal operation,

◦ Laser  was  connected  and  controlled  by  the  EdgeWave  Laser
Control  Software.  During  the  normal  operation,  the  emergency
stop is pressed,

◦ Laser  was  connected  and  controlled  by  the  EdgeWave  Laser
Control Software. During the normal operation, the Laser power is
shut off on purpose or not,

the software will try to reconnect the Laser when the hardware connection
is fixed, emergency stop is released and the power is turned on.

The software will not try to reestablish the connection if it is disconnected manually by the
Connect/Disconnect function described in section ??.

 3.6.2 Hot keys

Figure 13: Options - Hot keys

Hotkey  provides  easier  control  in  the  software.  To  change  the  key
combination used for certain function, use mouse to move the input focus into
the corresponding edit box and then press the hotkey to be assigned to.

The software will NOT perform a conflicting check when assigning hotkeys. Please check all
these fields carefully and avoid using the following hotkey which have been assigned to other
functions: Alt+X, Ctrl+O, Ctrl+D, Ctrl+C, Ctrl+V, F1 and Ctrl+1 ~ Ctrl+9.

• Connect / disconnect Laser

Set the shortcut to establish / cut connections to laser

• Internal Trigger

Set trigger mode to Internal for all branches.

• External Trigger

Set trigger mode to External for all branches.
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• CW mode

Set trigger mode to CW for all branches.

• Laser ON

Turn Laser state to ON.

• Laser OFF

Turn Laser state to OFF.

• Set current to 0

Set nominal currents of all  branches to 0A.

 3.6.3 Preset currents

Figure 14: Options - Preset currents

This feature provides a faster  way to change the laser current easily.  The
most frequently used current values can be set here and saved. When Laser
is connected, pressing Ctrl+1 ~ Ctrl+9 will set the nominal laser current to the
value  listed  here.  If  the  Laser  has  2  branches,  nominal  currents  of  both
branches will be set according to the preset value simultaneously. 

If the preset value is larger than the maximum current of the corresponding Laser branch, the
maximum value will be used instead.

The decimal separator must be dot.

 3.6.4 Save settings
The  configuration  of  EdgeWave  Laser  Control  is  stored  in  the  file  called
EWLaserControl.ini located at the same directory as the control software itself
(EWLaserControl.exe).  The settings including the options introduced above
and  the  position  of  the  main  window  will  be  loaded  when  launching
EdgeWave  Laser  Control.  If   EWLaserControl.ini  cannot  be  found  or
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corrupted, default settings will be loaded.

When the software is closed, all  settings will  be written into the setting file
automatically. The software will create one if  EWLaserControl.ini  cannot be
found and current Windows user has the privilege to create a file at the same
folder.

Backup of the settings can be done by making a copy of EWLaserControl.ini.
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4 Command line switch
Command line switches are some expressions appended at the end of the
command  used  to  launch  EdgeWave  Laser  Control  Software.  It  provides
another way to override settings saved in the file EWLaserControl.ini.  The
overridden settings can still be changed after the software is started and the
change will be written to the settings file as well.

This  feature  requires  EdgeWave Laser  Control  Software  version  3.0.2.63 or  above.  The
version can be found in the about dialog.

 4.1 Syntax
The following rules apply to the usage of command line switches:

• Expressions in square brackets (between '[' and ']') are optional.

• The dots “...” is the place holder for similar expressions.

• Expressions  in  curly  braces  ('{'  and  '}')  mean  that  instead  of  that
Expression  (including  braces),  the  actual  string  or  value  must  be
substituted.

• Expression

expression1 | expression2 | ... | expressionN

means  that  any  (but  only  one)  from  these  expressions  must  be
specified. 

• All switch commands are case insensitive.

• Space(s) in command line is considered as the separator of switches.

The syntax of using command line switches is explained below:

EWLaserControl.exe [<switch>] [<switch>] ...

<switch> = <switch_symbol><switch_command>:{switch_parameter}
<switch_symbol> = '-' | '/'
<switch_command> = 'port' | 'left' | 'top'

Example:
EWLaserControl.exe -port:3 -left:100 -top:150

 4.2 Command line switches
When  start  EdgeWave  Laser  Control  Software  from  windows  Command
Prompt window, the switches can be effective simply by append them in the
command line.  They can  also  be saved in  a  windows shortcut  for  easier
access in the future. Please follow the steps below:

1. Right click the shortcut of EdgeWave Laser Control Software created
during installation with mouse. And then left click on Properties.

2. Input  desired switches behind the EdgeWave Laser Control Software
path in the Target filed.

3. Click OK button to close the dialog.

New settings will be effective on the next startup by clicking on this shortcut.
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Figure 15: EdgeWave Laser Control - Shortcut properties

 4.3 Switch commands
Command

Word
Parameter

Type
Description

PORT Integer The serial COM port connected to the Laser. Specify 1 for
COM1, 2 for COM2 and so on.

LEFT Integer The  position  of  the  main  window on  the  active  windows
desktop in the unit of pixel.

TOP Integer
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Appendix A Multiple Lasers support
More than one running instance are  allowed for  EdgeWave Laser  Control
Software,  which  makes  it  possible  to  control  more  than  one  EdgeWave
Lasers simultaneously if there are enough RS232 interface available (one for
each  laser).  There  are  3  ways  to  control  multiple  lasers  with  the  same
computer at the same time using EdgeWave Laser Control Software.

1. Only one copy of EdgeWave Laser Control Software exists. Launch it
for multiple times and than choose the right COM port for each one.

In this case, options will  be saved every time a instance is closed. But all earlier
version will be overwritten and eventually only the last one persists.

2. Make 2  or  more copies  of  EdgeWave Laser  Control  Software with
different names in the same folder, or same name in different folders.
Each copy has independent settings to control a EdgeWave Laser.

3. Use the command line switches to create different shortcuts pointing
to the same copy of EdgeWave Laser Control Software. 

In this case, every running instance will share most of the same settings by default,
especially the preset currents.
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Appendix B Troubleshooting
Only the issues related to the EdgeWave Laser Control Software itself are listed below. For 
those of the Laser hardware, please refer to the Laser manual.

1. Cannot open port
Symptoms A dialog (Figure 16) appears when try to connect the Laser 

automatically or manually.

Figure 16: Cannot open port

Diagnose Double check the port number. Available COM ports can be found
in  the device  manager of  Windows,  or  in  the options  dialog of
EdgeWave Laser Control Software.

Check whether the connection between the device and computer
is good or not, if a USB-to-RS232 adapter is used.

A COM port is opened exclusively in Windows, which means only
one  program  can  use  the  port  directly  at  any  time.  Close  or
disconnect the other program which is using the specified port and
then try again.

2. Cannot find the main window
Symptoms No EdgeWave Laser Control Software window can be found.

Diagnose Check if the software is launched.

Search on the windows task bar  which normally  located at  the
bottom of the desktop.

Look for the icon  in the system tray area. If found, single click
with left mouse button will bring the main window back. Uncheck
“Minimize to system tray” in the menu can deactivate this feature.

3. Cannot connect the Laser
Symptoms There is not “Cannot open port” error. But the main window always

shows Laser disconnected even after click the Connect button.

Diagnose Check the COM port.

Check the connection of RS232 cable.

Check if the RS232 cable is a 1-to-1 cable.

Check if the power supply of Laser is connected to the mains and
switched on.

Check if the emergency stop button is engaged.
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Appendix B Troubleshooting

Check if the safety loops is connected well.

4. System hangs up when connect
Symptoms The windows system is slowed down dramatically or hangs up and

the software has no response when trying to connect.

Diagnose This is mostly caused by the failure of the COM port hardware or
software driver. Try to use another port or computer.

5. Input current error
Symptoms The dialog (Figure 17) appears when sending a new current value.

Figure 17: Value error

Diagnose There is a space character between the first digit and the decimal
point which makes the format of the string invalid. “02. 0” will bring
this  warning  as  well.  The  solution  is  to  use  “  2.00”  or  “02.00”
instead in case of Figure 17. It is recommended to input 4 digits in
the nominal current box, which means  to include the leading and
trailing 0.

6. Initialization of connection fails
Symptoms “Laser Disconnected” is always shown, but the serial number of is

displayed in the title bar in a flash and then become “INNOSLAB”
again. This repeat every time try to establish the connection.

Diagnose Contact EdgeWave with the Laser serial number.
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